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Client Software Installation 
The Client software is for general use of the FaxFinder, but it needs to be associated with a FaxFinder 
unit for proper operation. Your administrator should provide the software or a location where it can be 
obtained from. You will need to install the Client software on your PC and set the FaxFinder that it is to 
work with. 

Installation 

A. Insert the FaxFinder Product CD into the CD-ROM drive of the client PC. If the CD does not auto 
start, use Windows Explorer to navigate to your CD drive and launch the installation program by 
double-clicking on cd_start.exe file on the CD. From the menu presented, click the Software 
button. 
From the new screen presented, select the Client Software button to install the Multi-Tech 
FaxFinder Client software for using the FaxFinder unit. 

- or - 

Retrieve the software installer from the location provided by your administrator. 
 Double-click the filename (default is FFClientInstall.msi) to begin the installation. The file labeled 
FFClientTSinstall is for Windows Terminal Services only. 

Important: If you have any old versions of the FaxFinder client software installed (for any FaxFinder 
model family), please uninstall that prior to installing the new version. The FaxFinder client 
utilizes Windows Add or Remove Programs utility in the Control Panel. 

 
  



Installation 

Multi-Tech Systems, Inc. FaxFinder Client User Guide 5 

 
B. At the Welcome screen, click Next. 

 

C. At the Select Installation Folder screen, browse to the desired file location for the FaxFinder 
client software. In most cases, the default file location is recommended. 

 

Clicking on the Disk Cost button will show you the size of the software being installed as well as the 
available disk space of the target drive. 

When the destination location is correct, click Next. 
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D. At the Confirm Installation screen, click Next to begin the installation. 

 

A transient screen (“Installing FaxFinder Client Software”) will appear while files are being 
copied. 

 

E. The FaxFinder Client software can place a shortcut in the Startup directory so that the client 
software will start automatically when the PC is booted. 

 

F. You will be asked if you want the Client software to automatically launch when the installation is 
complete. Select your preference. 
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G. You will be asked whether or not you want to associate .tif and .cpg files with the Multi-Tech Tiff 
Viewer. Click Yes (unless you prefer to use a different viewer program). The .cpg files become 
associated with the Cover Page software. 

If a Question screen appears asking "Warning - the extension .tif is already registered, 
Overwrite?”; click Yes if you wish to use the TIFF viewer installed with the FaxFinder Client 
Software. Click No if you prefer to leave the current association for viewing .tif files. 

H. Then the Installation Complete screen will appear.   

 

Click the Close button. 

If you chose ‘Yes’ above to have the client software start after installation, you will see the 
application icon down in your System Tray. Click on the icon and select “show FaxFinder Client 
software” to use the program. 
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Associating Client Software and User with a FaxFinder Unit 

After the FaxFinder client software is installed, you must associate it with one or more FaxFinder units. 
Sometimes more than one FaxFinder unit is available for use. In some cases, certain client users might 
be assigned to some FaxFinder units and not assigned to others. This procedure shows you how to make 
this association so that faxes may be sent from a particular FaxFinder unit to the email inbox of your PC. 
To do this procedure, you will need to know the IP address of the FaxFinder unit that you are able to 
use. You should also be given a valid username and password for every unit that you can use. Be aware 
that an individual FaxFinder client user can be associated with more than one FaxFinder unit. This could 
easily be the case in an office that is large and/or an office that has a great deal of fax traffic.  

The icon for the FaxFinder Client software application will appear in the Windows Start menu programs 
selection. After installation, the Client Software starts up whenever the computer is booted if the ‘Yes’ 
option was chosen when the ‘Do you wish to start the FaxFinder Client automatically?’ prompt appeared 
during installation. When running, a FaxFinder icon appears in the system tray area at the lower-right 
corner of the screen. The FaxFinder Fax Client Software screen can be opened from either the Start 
menu icon or the tray icon. If the Client Software is shut down, it can be re-opened from the Start menu 
or by double-clicking on a file named FaxFinderClient.exe (or something very similar), which, following a 
typical, default installation, is located at C:\Program Files\Multi-Tech Systems\FaxFinder Client 
Software\FaxFinderClient.exe. When the client software is launched, it will reside in the System Tray be 
default. 

 
System Tray Icon 
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1.  At the main screen of the FaxFinder Fax Client Software, click on Edit and select “Add FaxFinder” if 
you know the IP address or Host Name of the FaxFinder, otherwise open the Tools menu and select 
“Auto-Discover Devices” to have the Client software search the network for FaxFinder units. 

 

Add FaxFinder Manually 

 

 

Use Auto Discover to Locate FaxFinder 

a. If you are using the Auto Discover Device method, click the ‘Search’ button to have the 
FaxFinder Client software search the available network for FaxFinder units that are available. 
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2.  To add a FaxFinder when the IP address is known, select the FaxFinder model family from the Type 
drop-down, enter the IP address “Server Address” field along with your Username and Password. 

 

 

If the Auto Discover Devices feature was used, you may Right-click or double Left-click on the IP 
address or name of the FaxFinder unit that was detected and select Add. Use the ‘X’ in the upper 
right hand corner to close the Auto Discover window after you have added it to the client. 

3. Enter, in the appropriate fields, the Username and Password that the client will use when accessing 
this FaxFinder unit. If the client is to be associated with multiple FaxFinder units, a different 
Username and Password could be established for each. However, in most cases, it is advisable (for 
the sake of simplicity and convenience) to use the same Username and Password for all FaxFinder 
units.  

 
NOTE:  The Username entered here must match the entry used in the “Username” field of the Users 

screen in the FaxFinder Server Software. The password entered here must match the 
password entered for this client.  
The Username and Password are case-sensitive. 

Click OK. 
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4. A new FaxFinder entry should appear on the “Device Status” tab of the FaxFinder Fax Client 
Software screen.   

 

The status of the newly registered FaxFinder unit may momentarily go from “Not logged in” to 
“Logging in” to “Connected.”  

If it goes to Login Failure, then one of two things is wrong: 

a. The IP address or domain name is wrong. If that is the case, delete that entry (by right-clicking 
DELETE), and enter a new one; 

- or - 

b. The Username/Password combination may be wrong. Verify that the client Username/Password 
combination (accessible by right-clicking and selecting Properties on the FaxFinder listed in the 
Device Status tab of the client software) matches the Username/Password combination assigned 
to the client-user by the FaxFinder Administrator. 

Note: Username and Password are case-sensitive. 

Disassociating the Client from a Specific FaxFinder Unit 

In this procedure, you will un-do the procedure “Associating Client with a Specific FaxFinder Unit.” This 
situation might occur when changes are being made in the network faxing system. In any event, this 
procedure severs the tie between your PC and a specific FaxFinder unit so that you will no longer be 
connected to it for sending fax messages. (Faxes can be received in email form from the FaxFinder 
server, despite disassociating from the FaxFinder server, as long as the receiving party is entered in the 
FaxFinder Phone Book.) In cases where the client is currently associated with more than one FaxFinder 
unit, you will need to know the IP address of the specific FaxFinder unit from which you want to 
disconnect. 

1. Open the FaxFinder Client Software program and go to the Device Status tab. Select the FaxFinder 
unit from which you want to disconnect (you can identify the FaxFinder unit by its IP address or 
domain name), Right-click on it and select delete. 

2. Your FaxFinder Client Software will no longer be able to send faxes through this particular FaxFinder 
unit. 

 



 

  

FaxFinder Operation 

Introduction 
This chapter describes the things that a user can do with the FaxFinder system. The software programs 
involved are the FaxFinder Client Software and the Multi-Tech Tiff Viewer (or designated PDF viewer). 
The FaxFinder Client Software interfaces with the FaxFinder Server and has its own user interface. When 
previewing outgoing faxes, the PC’s operating system calls up the designated TIFF viewer to display the 
outgoing fax. When viewing received faxes, the PC’s operating system calls up the appropriate viewer 
(PDF or TIFF). The choice of file types (PDF or TIFF) is made in the FaxFinder Server software. Note that 
client users can choose to display either on the Multi-Tech TIFF viewer or on a different (non-Multi-
Tech) TIFF viewing program. Likewise, if the FaxFinder system distributes incoming faxes as PDF files, the 
client can designate which PDF viewer to use. The Multi-Tech TIFF viewer is installed automatically with 
the FaxFinder Client software. Overview: 
Sending Faxes 

 The FaxFinder Schedule Fax Screen (New Fax) 
 Send Fax with Client Software 
 Send Fax by Printing 
 Send Fax from Email (T.37) 
 Send Fax from FaxFinder Web Interface 
 Send Fax by Web API 

Using the Client Software 
 Details of Software Commands 

o Add a contact 
 Using the Cover Page Generator 
 Using the Tiff Viewer  
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Sending Faxes 

Sending faxes through the FaxFinder is quick and simple and offers a variety of methods that can be 
used to accomplish this. This section will show all the possible ways to send a fax with the FaxFinder. 
Depending on how your administrator has set up the unit, several or even all options may be available. 
First, the FaxFinder Schedule Fax window will be explained as it is used for the majority of faxing through 
the FaxFinder unit. 

The FaxFinder Schedule Fax Screen (New Fax) 

 
The FaxFinder Schedule Fax screen appears (a) when you double-click an item from the Print Capture 
tab of the client, or (b) when you select the New Fax command from the File menu of the Client 
Software screen or (c) when you Right-click an item in the Print Capture tab and select ‘Fax.’ 

There are four sections (called ‘panes’ hereafter) to the Fax Scheduler: the Recipients pane, the 
Documents pane, the Options pane and the Cover Page pane. At the bottom are the two main function 
buttons – one to send or schedule the fax and the other to cancel it entirely. 
 

Device pane 

The device pane provides a drop-down list of all FaxFinder units available to this client. Select the unit 
that you want this fax sent from. 
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Schedule Options pane 

 

 
 

Options text box: This text box will display ‘Send Immediately’ by default. If you want to schedule this 
fax to be sent at a specific time or date, then you must click the Options button. 

Options (button): If you want to specify a time or date for the fax to be sent, you must click the Options 
button which will open the Fax Scheduling Options window. The Options button will also allow 
you to change the Maximum Attempts, Priority and Fax Receipt options from the default values. 

 Fax Scheduling Options 

 

 
 

 By un-checking the ‘Send Immediately’ box, you can set a specific time and date for this fax to 
be sent. You may change the Maximum Attempts, Priority and Fax Receipt settings for this fax. 
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Recipients pane 

 

 
 

Name (column): Party to whom the fax will be sent. You cannot type in this window. When a recipient is 
specified either from the Contacts or from the Enter a Fax Recipient window, that recipient’s 
name will appear in this field. 

Fax Number (column): Fax number to which the fax will be sent. You cannot type in this window. When 
a fax number is specified either from the Contacts or from the Enter a Fax Recipient window; 
that fax number will appear in this field. 

+ (button): Brings up the Enter a Fax Recipient window. At this window, you enter the name and fax 
number of the party to whom the fax will be sent. 

— (button): Removes a selected (left-click to select) entry from the Recipients list. You will be prompted 
(by the FaxFinder – Delete? screen) to confirm removal of the recipient from the list of 
recipients. 

Contacts (button): Brings up the Select Contacts screen from which a fax recipient can be chosen (this is 
retrieved from the user contacts stored in your user ID on the FaxFinder unit). If enabled on the 
FaxFinder server, this will also display contacts from Microsoft Outlook. Multiple entries can be 
selected by holding the Ctrl key (individually) or Shift key (all entries between) while clicking. 

 

Documents pane 

 
 

Document (column): File name and type extension of document(s) to be transmitted as a fax. 
+ (button): Click this button to add another document to the fax transmission. Only .tif, .pdf and .txt files 

can be added with this. 
— (button): Click this button to remove a document from the list of items to be faxed. You will be 

prompted (by the FaxFinder – Delete? screen) to confirm removal. 
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Cover Page pane 

 

 
 

Use Cover Page (check box): Check this checkbox to include a cover page with your fax. 
Cover Page (drop-down selection box): This field will be active when the ‘Use Cover Page’ check box is 

ticked. By clicking on the down arrow, you will see the selection of cover pages available from 
the FaxFinder unit. Click to highlight and select the cover page you want to use. 

View (button): Brings up the cover page to be used. 
Subject (text field): Here you can type a brief description of the contents of the fax. The placement of 

this “Subject” description will depend on the cover page style that you use. 
Comments (text field): Here you can type a lengthy comment about the fax or related topics. 
 
 

Send the Fax 

 
Schedule (button): When you have completed the other sections, click the Schedule button to have the 

fax sent according to the time set by the Options parameters. 
Close (button): To exit the Fax Schedule window and discard all changes, click the close button. 
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Send Fax with Client Software 

When a document (.tif, .pdf, or .txt) is complete and ready to be sent as a fax, opening the client 
software and using the Schedule Fax option is quick and easy.  
To begin, either double-click the FaxFinder Client Software icon in the System Tray or launch it manually 
from the program listing on the Start menu, which will place it down in the System Tray. 

 
1. Right-click on the FaxFinder unit that you want to send the fax from and select ‘New Fax’ 
2. The Fax Scheduler screen will open 
3. Enter recipients manually by clicking the ‘+’ button or select from an already available contact 
4. Click on the ‘+’ button to the right of the Documents window and browse to the file you want 

sent (you may add more files by repeating this step) 
5. Highlight and click Open to use the selected file 

Note: If you do not see the file you want to use, make sure that the type of your source file 
(PDF, Text, Postscript, Tiff) is valid 

6. Set any Options that you need (priority, time to send, etc.) 
7. Select and modify a cover page as needed 
8. Enter a subject and/or comments if needed 
9. Click the Schedule button in the lower left corner to send the fax according to the options set 

 

Send Fax by Printing 

The easiest and most convenient way to utilize the FaxFinder once the client software is installed on a 
computer is to take advantage of the Print function of a software program.  
To begin, create the text that you want to send out as a fax and save your work. 

1. Select the Print option from the software you are using 
2. Select the FaxFinder as your print destination and click on the Print button 
3. The Schedule Fax window opens 
4. Enter recipients manually by using the ‘+’ button or select from an already available contact list 
5. Set any Options that you need (priority, time to send, etc.) 
6. Select and modify a cover page as needed 
7. Enter a subject and/or comments if needed 
8. Click the Schedule button in the lower left corner to send the fax according to the options set 
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Send Fax from Email (T.37) 

When you wish to send an email as a fax, using the T.37 format in the To: field will take advantage of the 
FaxFinder from your Outlook email software. To do this you will need to know a few things: your 
administrator should provide you with the domain name of the FaxFinder unit and you need to know 
the phone number of the fax recipient. 
To begin, compose the message as a new email. 

1. In the To: field, enter the recipients in this format: FAX=phone number of recipient fax 
machine@FaxFinder domain (e.g. FAX=7635551234@faxfinder.example.com as shown below) 

 
2. Add any graphical attachments (PDF, Text or Tiff) 
3. Click the Send email button 

Send Fax from FaxFinder Web Interface 

Logging in to the FaxFinder unit via a web browser is another simple way to have a fax sent from the 
FaxFinder unit. This process is started by simply entering the IP address (e.g. 192.168.2.1) in the address 
bar of the browser and using the links to access the Send Fax screen. Depending on the browser used, 
you may see security warnings. Click ‘Yes’ to proceed in Internet Explorer; for Firefox, you may have to 
add an exception for the FaxFinder unit’s IP address. 
To begin, enter your Username and Password. 

1. Click on the top navigation link “Send Fax” 
2. The Sender Information will be pre-entered with your user info 
3. Enter the recipient information or select from an available contact list and click ‘Add Recipient’ 
4. Select and fill out any information to be included as a cover page if you are using one 
5. Browse to the file that is the fax information (you can add more with the ‘Add Another 

Attachment’ button) 
6. Choose any option variables for this fax 
7. Click the Send Fax button at the bottom left of the screen 
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Send Fax by Web API 

If your administrator has created a custom API (Application Programming Interface) for you to use, that 
is another option available for sending faxes through the FaxFinder. This will be unique for your 
company, so you should look for information from your Administrator or IT department. 
 
 

Using the Client Software 

This section will detail all of the commands, tabs and screens that the Client Software offers. While not 
every user will need all of the options available, you may want to glance through what is here for 
something that will prove useful to you. The Schedule Fax command is the primary means of sending a 
fax through the software and populating the address book can save time by having those contacts 
readily available when a fax needs to be sent. 

File Menu Command Descriptions 

The following options are available from the File menu. 

 

File menu Commands 

New Fax: Clicking this command will bring up the ‘Schedule Fax’ window of the default FaxFinder unit, 
where a user can enter the needed information and schedule a fax to be sent by the active 
FaxFinder unit. 

Exit: This will exit the FaxFinder Client software. You will be prompted with a pop-up verifying that you 
actually want to exit the software. Another option is to click on the window minimize button to 
return the FaxFinder client to the system tray. 
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Edit Menu Command Descriptions 

The following options are available from the Edit menu. 

 

Add FaxFinder 

The following will detail the sections available from the Edit | Add FaxFinder menu. 

 

Type: Select the FaxFinder series you are connecting to. 
FFx30 for the FF130, FF230, FF430 and FF830 

 FFx20 for the FF120, FF220, FF420 and FF820 
Server Address: Enter the IP address of the FaxFinder unit that you want to add. 
Username: Enter the user name you have been assigned for this unit. 
Password: Enter the password associated with the user name you have been assigned for this unit. 

Click OK to add the new FaxFinder unit to the client software. 
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Options 

The following is available from the Edit | Options menu.  

 
Date/Time tab:  

Here you enter the date and time formats for the fax header. 

Advanced tab:  

Here you designate the circumstances that will make the Send Fax window become minimized and allow 
the enabling of the importation of a Microsoft Outlook address book. Include Outlook contacts will 
automatically find your Outlook (2000 version and newer) folder and import the contacts that exist 
there. 

Logging tab:  

A Trace Level of 9 is the highest trace setting. A Trace Level of 1 is the lowest (least amount of trace) 
setting. 

Select Save Log on Exit to ensure the Log file exists after the application is closed. 

Select Save Log to if you want to create a log file other than the default. You may Browse to an existing 
File Folder and type in the name of the custom log file in the edit field. 

Click View Log to view the existing log file. 

Click Delete Log to erase the current log. 

Click Delete All Logs to remove any previously existing Log Files. 

Click Restore Defaults to restore the Logging information to factory defaults. 

Click View Application Data to start an explorer window to find and view existing log files. 

Click OK to save your changes. 

Click Cancel to Cancel any changes made. 
  



FaxFinder Operation 

Multi-Tech Systems, Inc. FaxFinder Client User Guide 22 

Tools Menu Command Descriptions 

 

Auto Discover Devices: Selecting Auto Discover Devices will have the Client software search the network 
for active FaxFinder units that are on the same network. 

 Click on the Search button to begin the auto discovery. Once begun, you can click the Stop 
button to end the search at any time. When you are finished, click the Close button. 

 Any device found can be added by right-clicking and selecting Add or double-clicked to add it to 
the Client software. 

 

FFx20 Cover Page Edit: Selecting this option will open the FaxFinder x20 Cover Page Editing software 
that was installed with the client. The software allows you to edit existing covers pages or create 
entirely new ones for the FaxFinder x20 models only. 
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Device Tab (Main Window) 

The Devices tab will show all of the FaxFinder units that are associated with the client software. This 
window has three columns: Host (the name or IP address of a FaxFinder unit), Model (the model number 
of the FaxFinder unit) and Status (displays the connection state of the FaxFinder unit as well as showing 
which unit is set as the default unit for use). By right-clicking on the name or IP address of the FaxFinder 
unit in the Host column, you will get an option window. 

 

Open 

Selecting Open (or double-clicking the FaxFinder host) will launch the FaxFinder summary window. 

 

 Fax Status tab 
 This tab will show the name, number, time, pages, state and subject for any pending or sent 

faxes. 
 Contacts tab (Add a Contact) 
 The contacts tab lists all the contacts that are associated with your user name in the FaxFinder 

unit. 
  Right-click menu 
  By right-clicking on an existing contact you can Edit or Delete it. 
  By right-clicking in the empty area, you can Add Contact or Refresh the screen. 
 User Info tab 
 The user info tab lists your information as it is entered in to the FaxFinder unit.  
  Save (button) 
  The Save button will save any changes made to the User Info on the FaxFinder unit. 
  Retrieve (button) 

The retrieve button will query the FaxFinder unit for the current user information and 
update what is displayed in the client software. 

 Options tab 
 In the options tab you can change the default settings that are used for faxing: Max Attempts, 

Fax Priority, Fax Receipt, Try Interval. 
  Save (button) 
  Click the save button to make these changes to the FaxFinder unit for this user.
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Delete 

Selecting this will delete the FaxFinder unit from use by this software. There is a delete confirmation 
window that will pop-up prior to actual deletion. 

Set as Default 

Selecting set as default will make the unit clicked the default unit for sending faxes through this 
software. 

Properties 

Selecting properties will bring up a window showing the FaxFinder unit type (FFx20 or FFx30), the IP 
address the unit is using and your user name and password. The password is replaced by asterisks for 
security. 

 

Print Capture Tab (Main Window) 

Any potential faxes sent from the print to FaxFinder option will be here, ready for additions, setting 
changes or scheduling. There are two columns to this field: Document (the name of the document ready 
to be scheduled) and Pages (the total number of pages in the document). To access the options for 
items in the print capture area, right-click on the document name. 

 

Fax  

Selecting this will open the Fax Scheduler window allowing you to change any parameters as needed 
and schedule your fax for a specific time or send it immediately. The Fax Schedule screen is covered 
earlier in this chapter. 

Delete 

Selecting this will permanently delete the document from the client software. Entries in the Print 
Capture tab will remain until they are manually deleted using this command. 

View 

Selecting the view option will open the document (a TIFF file) with the program associated with its 
extension type; if you chose to associate TIFF files with the TIFF Viewer during the installation, that is 
what will open the file. 
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Using the Multi-Tech Tiff Viewer 

The Multi-Tech Tiff Viewer program has a variety of features that enhance the viewing of fax messages 
in graphic file form (thumbnails, zooming, spot magnification, scrolling, rotating, etc.). The program can 
also manipulate and permanently alter the graphic files. 

Toolbar Icons 
The most commonly used functions are available as icons on the toolbar. In the diagram below, we label 
the functions of these icons.  

 

While most of these features are common to many graphical programs, some warrant a bit of 
explanation, provided below. 
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Copy. The Copy function allows you to copy the fax file and insert it into a different application program. 
When you click the copy button, the current image will be copied to Windows Clipboard, from which 
you may then Paste into another applicable program or document. See “Importing Fax Images into 
Other Application Programs” below. 

Pan (Omni-Directional Scroll). The “hand” icon allows you to bring any desired portion of the image into 
view by clicking and holding down the left mouse button and then moving the mouse to “drag” the 
image to where you want it. 

Zoom to Selection. Click and drag with the mouse over the rectangular area you would like to view. The 
Multi-Tech Tiff Viewer zooms in sufficiently to fill the screen with the selected area. 

Magnify Area (Spot Magnifying Glass). In this viewing mode, a magnifying glass icon (cursor) appears. 
It can be used in one of three ways to magnify any portion of the image: (a) Click over Area, (b) Click-
and-Hold Over Area, (c) Scan the Graphic. 

Click over Area. A secondary window will appear that shows the ‘clicked-on’ area magnified. You 
can adjust the size of the secondary window by dragging on its borders. You can re-locate the 
secondary window by putting the cursor inside the window, clicking, holding, and dragging. 

Click-and-Hold over Area. Two additional windows will appear. The cursor itself becomes a small 
secondary window of fixed size. The same image also appears on a third window. You can adjust 
the size of the secondary window by dragging on its borders. You can re-locate the secondary 
window by putting the cursor inside the window, clicking and dragging.   

Scan the Graphic. If you click, hold, and drag, you can scan the image in a magnified view. Two 
magnifying windows will appear as in the “Click-and-Hold Over Area” description above. 

Thumbnail. The thumbnail shows a reduced size version of the current image as well as the dimensions. 
If you left-click on the thumbnail image, you will reset the current graphic to the original. This will not 
undo any changes that were saved. 

Importing Fax Images into Other Application Programs 
The Copy command in the Multi-Tech Tiff viewer program allows you to import the fax image into other 
application programs. A fax, in the TIF format can be Copied from the Multi-Tech Tiff viewer program 
and Pasted into a word processing program document. The Windows Clipboard will only hold one copy 
at a time, so make sure not to use any copy command until you have pasted the current image to the 
new location. 

 


	Client Software Installation
	Disassociating the Client from a Specific FaxFinder Unit

	FaxFinder Operation
	The FaxFinder Schedule Fax Screen (New Fax)
	Send Fax with Client Software
	Send Fax by Printing
	Send Fax from Email (T.37)
	Send Fax from FaxFinder Web Interface
	Send Fax by Web API
	File Menu Command Descriptions
	Edit Menu Command Descriptions
	Tools Menu Command Descriptions
	Device Tab (Main Window)
	Print Capture Tab (Main Window)


